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A͘ Head CiƌcƵmfeƌence PƌŽcedƵƌe 
ObƐeƌǀaƚiŽn EƌaƐmƵƐ MC 
 

The following is a written account of the procedure for taking the head circumference of a preterm 
infant at the Erasmus MC NICU. Due to privacy concerns, no images or audio could be recorded. The 
entire procedure took about 5 minutes. The events are presented in chronological order. The two 
nurses performing the measurement will be referred to as Nurse A and Nurse B. 

1. Nurse A lifts the blanket covering the incubator, while at the same time nurse B slowly opens 
the windows blinds of the windows situated next to the incubator. The child is flailing its 
limbs around in the incubator 

2. Both nurses take a seat on a small stool, on each side of the incubator 
3. The nurses both open the side access hatches of the incubator on their respective sides 
4. Nurse B reaches in and gently cradles the infant in her hands, one hand below the body, the 

other supporting the head near the neck. 
5. Nurse A has a tape measure and reaches into the incubator from her side 
6. Nurse A puts the tape measure around the head of the infant and slowly pulls the tape tight. 
7. Nurse A pronounces the pronounces the measurement she reads and asks nurse B if she 

agrees. 
8. Nurse B looks at the tape and confirms the measurement. 
9. Nurse A removes the tape measure from the infant’s head and closes her side of the 

incubator. 
10. Nurse B puts down the infant, rearranges some wiring and tubing, and closes her side of the 

incubator 
11. Nurse A puts the measurement in the digital patient file using the computer next to the 

incubator. 

This concluded my allotted time to observe the procedure. I assume the window blinds were 
closed and the blanket put back on the incubator, but I did not observe this. 
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B͘ EͲmail Inƚeƌǀieǁ ǁiƚh EƌaƐmƵƐ MC 
NICU NƵƌƐe 
 

The following is a list of questions and answers I got from one of the nurses at the Erasmus MC NICU. 
This interview was supposed to take place in person in March 2020, but was cancelled and changed 
into an e-mail interview due to the COVID-19 pandemic. 

 

Interviewer 

Interviewee 

 

Groei en schedelomtrek 

Waarom wordt de groei van prematuren bijgehouden? 

 

Een goede groei geeft een betere outcome 

 

 

Wat duidt de huidige schedelomtrek meting aan? Bijvoorbeeld; is het alleen voor neurologische 
ontwikkeling, of wordt het ook gebruikt om lengte te extrapoleren? 

 

Zegt iets over de verhouding. Je kunt een lichamelijke groeiachterstand hebben en behoud van groei 
schedel (hersenen) en een groeiachterstand die ook effect heeft op de groei van de schedel en 
daarmee de hersenen 

 

 

Is de schedelomtrek meting relatief of absoluut. Dat wil zeggen, is het getal dat uit de meting komt 
op zichzelf belangrijk (geeft het een staat van ontwikkeling aan), of wordt er gekeken naar een 
ontwikkeling ten opzichte van de laatste meting? 

 

Er wordt gekeken naar de ontwikkeling 

 

 

Wat is in uw ervaring de precisie van de schedelomtrek meting (bijv. 1mm, 1cm, enz.?) 
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Over het algemeen halve centimeters 

 

 

Een mogelijke functie van het ontwerp is het maken van een 3D beeld van het hoofd van de 
prematuur, waarop direct of later metingen gedaan kunnen worden zonder de prematuur hier verder 
bij te betrekken. Zou deze functionaliteit naar uw mening toegevoegde waarde hebben? 

 

 

 

Positie van Prematuur 

 

Ik heb vernomen dat het hoofd van de prematuur eens in de zoveel tijd verlegd moet worden of 
ligplekken en schedeldeformatie te voorkomen. Hoe vaak gebeurt dit per dag/ Wat is de interval? 

 

Geen vaststaand interval, bij de verzorging. Meerdere keren per dag 

 

 

 

Licht 

 

Er is mij verteld dat Erasmus een dag/nacht cyclus voor de prematuren op de afdeling neonatologie 
creëert. Wat is het ritme van deze cyclus? 

 

Een dag/nacht ritme hebben prematuren nog niet. We proberen zoveel mogelijk rust te creeeren. 

 

 

Worden metingen en andere interventies alleen tijdens de dag, of ook tijdens de nacht van deze 
cyclus uitgevoerd? 

 

Tijdens alle diensten, ip 1 x per week 
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Prematuren krijgen een blauwlicht behandeling tegen geelzucht. Is dit standaard voor alle 
prematuren? 

 

Nee, afhankelijk van het bilirubinegehalte in het bloed 

 

 

Hoe vaak krijg een prematuur deze behandeling? 

 

Zie boven 

 

 

Hoe lang duurt de behandeling ongeveer? 

 

Afhankelijk van verschillende factoren, bilirubine is leidend 

 

 

De prematuren dragen oogbescherming tijdens de blauwlicht behandeling. Naar uw ervaring, 
veroorzaakt het opdoen van de bescherming stres bij de prematuur? 

 

Het bloot liggen en daardoor minder ondersteuning geeft stress.  

 

 

Hoe lang duurt het om de bescherming op te doen bij de prematuur? 

 

Aantal sec. 

 

 

Is dit een 1 of 2 persoon proces? 

 

Vaak een 1-persoons proces 
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Couveuse 

 

Hoe vaak wordt de couveuse ongeveer per dag geopend 

 

Geen idee, afhankelijk van toestand patient 

 

 

Is het belangrijk dit tot een minimum te beperken? 

 

Je in principe wel, maar je probeert ook te zorg niet in 1 keer te doen, maar te verdelen daar bij 
kijkend wat de patient aan kan en wat persee moet. 

 

 

Hoe belangrijk is direct zicht op de prematuur in de couveuse 

 

Belangrijk, je kunt dan zien of een kind wakker is op een bepaald moment zodat je de zorg nog beter 
kunt afstemmen 

 

 

Sommige couveuses op de afdeling hebben een deken over het glas. Is dit deken belangrijk voor de 
rust van het kind? 

 

Is voor privacy, voor minder licht in de couveuse. Intra-uterien is het ook niet licht 

 

 

Dit deken maakt het wellicht moeilijker om het kind visueel in de gaten te houden. Is dit zo, en zo ja, 
is dit hinderlijk? 

 

Ja, dit belemmert het zicht op de patient. Door het omhoog tillen van de beschermende deken, maak 
je vaak patient wakker. Beter is om de camera in de gaten te houden. 
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Meting 

 

U geeft aan dat de relatieve groei wordt gemeten om ontwikkeling van de patiënt bij te houden. Wat 
is volgens u een significante stap tussen twee metingen die een (gezonde) groei aanduidt (bijv. halve 
cm, 1cm, enz.)  

 

 

Dat is van veel factoren afhankelijk, bv orale voeding, speelt er ergens een infectie. Er wordt gekeken 
of patient zijn/haar eigen groeilijn volgt volgens de Fenton scale 

 

Camera 

U antwoordde dat als er een deken over de couveuse ligt het beter is om de camera in de gaten te 
houden dan de deken op te tillen, om zo het kind niet te storen.  

Bij mijn bezoek aan de NICU heb ik geen camera’s gezien. Heeft elke couveuse zijn eigen camera?  

Ja 

 

 

 

Waar is deze camera geplaatst (bijv. in de couveuse, tussen de couveuse en de deken, enz.)?  

Boven of op zijkant couveuse 

 

 

 

Is deze camera een permanent deel van de opstelling, of wordt deze alleen geplaatst wanneer 
nodig?  

Vaste opstelling 

 

 

 

Wordt de camera voor meer doeleinden dan alleen monitoren gebruikt?  

Nee 
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Couveuse 

 

Ik heb hier beschikking over een gebruikte couveuse kap. Deze bevat echter een aantal krassen en 
schrapen. Als u naar de close-up foto’s in de bijlage van de email kijkt, zou u zeggen dat dit een 
normale hoeveelheid krassen is voor een couveuse kap op de afdeling, of is het meer/minder dan op 
de afdeling?  

 

Is vergelijkbaar 
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C͘ IncƵbaƚŽƌ Maƌkeƚ Oǀeƌǀieǁ 
 

The point of this analysis is to determine If current incubators share certain design cues. Even 
though no official standard on incubator design has been published to my knowledge, perhaps a 
archetype of an incubator can still be created. The geometry of this archetype can then be used to 
create a generalized design for the product. 

Though proper research was attempted, the market for neonatal incubators is a very specialized 
one. Almost no advertisement can be found. data on amounts of incubators sold are not available, 
and brands do not talk about their market share. This makes researching these products challenging. 
Nonetheless, multiple models were found on the websites of resellers. Images of these incubators 
were downloaded and put into an image board in order to discover similarities. 

 

I found the following: Most modern freestanding incubators use a design like the Draeger Caleo 
currently used by Erasmus. This means that the incubator, in additions to the horizontal top and 
vertical sides, also features two diagonal sides for easy viewing of the infant while standing in the 
NICU. The only big exceptions are units made for wall placement. These units only feature a single 
angled pane, with the wall-side of the incubator being completely vertical. 
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D͘ Technology Overview 
In order to acquire the data necessary for cranial measurements, the product needs to employ a 
surface scanning technology. Previous chapters discussed a selection of those technologies already 
used or tested for infant cranial measurement. This chapter will expand on the functioning of those 
technologies as well as additional options. The goal is to make a selection of one or more 
technologies that will be used for the ideation and prototyping phases.  

 

Types of acquisition 

 

There are many different ways to acquire a surface scan. These are often divided into the contact 
and non-contact category, with the non-contact category being divided into active and passive 
acquisition (Figure FIXME) (Ebrahim, 2013).  

 

This division allows us to immediately eliminate certain techniques as candidate. Contact methods, 
for example, require a physical instrument to interact with the infant in order to acquire data. Not 
only would touching the infant cause stress, it would also require that the device be placed within 
the incubator. Thus, only non-contact scanning methods will be discussed. 

 

In addition, since only surface data is needed for measurement, volumetric scanning methods (e.g. 
MRI, CT), too, will not be considered. 
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Finally, active scanning methods emit radiation as part of their capture process, while passive 
scanners can rely on only environmental radiation. Thus, with active methods special consideration 
must be given to its suitability when scanning through the surface of the incubator. 

Overview 
The following is an overview detailing each technique that is considered for the product. In addition 
to a short description of its functioning, advantages and disadvantages of each technique are 
discussed.  

 

Laser Triangulation 
Laser triangulation is a simple form of 3D scanning, whereby a single laser and a camera are used to 
acquire depth data along the path of the laser line. The basic principal is as follows: 

x A laser and camera are positioned at a known angle D (Figure FIXME). 
x Depending on the depth of the object the laser point hits, it’s position on the camera sensor 

changes. 
x Using triangulation, this shift in position on the sensor can be translated into an absolute 

depth of the point (Figure FIXME). 
This concept can be expanded upon by projecting a laser line instead of a point using, for example, 
an oscillating mirror. This then give a depth “slice” of the object that is to be scanned. Moving the 
laser & camera setup, or the object, can be done to acquire multiple of these slices. Stitching these 
slices together forms a 3D surface scan of the object. 

  

Laser triangulation is adequately accurate, with a depth accuracy of 0.04mm being claimed by one 
report (Vukašinović et al., ϮϬϭϬ). At the same time, complete systems sell for a relatively low price. 
Murobo sells a turntable based model (where the to-be-scanned object is rotated instead of moving 
the laser assembly) for $249,- (Murobo, n.d.). 

 

Intrinsic performance variables 
x D: The value of D determines both the depth resolution of the setup, and the sensitivity of 

the setup to occlusion. The depth resolution and sensitivity to occlusion as a function of D 
are correlated. Thus, as D increases both depth resolution and sensitivity to occlusion 
increase, and vice versa. 
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x Laser line thickness: Influences the depth resolution of the system. The thinner the line, the 
easier the sensor can pick up small variation in the surface’s depth. 

x Sensor resolution: The higher the resolution of the used image sensor, the more detail it can 
pick up in the variations of the laser line height, which directly translates to increased depth 
resolution. 

 

Advantages 
Simplicity 
This system only requires a laser with a line generator prism, and a regular CMOS camera sensor to 
function, making the hardware setup relatively simple. 

 

Hardware costs 
This system is made up of only a few components, all of which are common, and mass produced, 
reducing the hardware costs significantly. 

 

Processing requirements 
The depth of every point of the laser line corresponds to a shift in vertical position of the line on the 
camera sensor. This correlation can be solved with simple trigonometry, making the computational 
requirements to acquire the actual depth of each point on the line relatively low. 

 

Non-visible light source 
This setup can be made working with an IR-A laser and a CMOS camera without IR filter. This 
prevents the infant from enduring stress from visible light being shone upon it. 

 

Disadvantages 
Obstruction 
Obstructions like blankets, tubes, or other above-the-infant objects, can cast a shadow when in the 
path of the projector. If these shadows are cast on the infant, the camera will not be able to gather 
any depth-data from those areas. 

 

2 Dimensional 
This system in its most common, static form can only capture a single line or slice of depth data. This 
means that the system must be positioned in the correct way by the NICU nurse for it to capture the 
right slice of the infant’s head for a HC measurement, increasing operation complexity and 
decreasing interobserver precision.  

Creating full 3-dimensional scans would require the laser beam to be moved along an additional axis, 
increasing mechanical complexity. 
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Structured Light 
 

 

This scanning technique, like laser triangulation, uses triangulation to determine the depth of a point 
on the surface on the to-be-scanned object. Where the two techniques differ is that laser 
triangulation can only acquires one line (or slice) of depth data at any given moment, while 
structured light scanning allows for the simultaneous acquisition of an entire 3d surface. The basic 
operation is as follows: 

 

x A light projector, placed at a known angle D and T to the camera (as in figure FIXME), 
projects a pattern of sorts (Figure FIXME) on the to-be-scanned surface. 

x The camera captures the distortion of this pattern on the surface, which is influenced by the 
depth of each point of the surface 

x Using one of the techniques outlined in figure FIXME, the software identifies each point of 
the pattern, comparing its shifted position to its original position. 

x Triangulation is used to determine the depth value of each point based on the shift from its 
original position, from the viewpoint of the camera. 
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Though all structured light scanners use the same principle of triangulation, various techniques exist 
for solving the problem of point recognition: For the scanner to determine the depth value of each 
point it must know the original position of the projected pattern point corresponding to it.  

 

Thus, the scanner must be able to uniquely identify each point of the projected pattern. (Geng, 
2011) grouped these techniques into single-shot and multi-shot methods (Figure FIXME). As the 
name suggests, single shot methods allow all necessary information to be captured by the camera in 
a single frame or ‘shot’, while multi-shot methods require multiple sequential frames to be captured 
in order for the pattern to be fully identified.  

 

To illustrate the difference between the categories, the following is an overview of two predominant 
technologies, one of each of the two discussed categories 
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Gray coding (multi-shot) 

 

With Gray coding, the projection is divided up into vertical or horizontal lines which are either black 
(no projected light) or white. These represent the binary values 0 and 1 respectively. By projecting 
and capturing a sequence of frames, these bars can be used to create a unique identifier for each 
line. Since each frame represents one state, or bit, the number of possibilities is equal to 2N, where N 
is the number of frames in a sequence. Thus, the more frames, the higher the amount of unique 
lines that can be identified, increasing the resolution of the scan until the camera sensor’s resolution 
becomes the limiting factor. 

 

Pseudo random binary dots / light coding (single-shot) 

 

This method, employed by the ubiquitous Kinect v1 camera, uses a laser generated pattern of 
pseudo random dots to identify areas of the pattern. The dots are arranged in such a way that a sub-
area of a predetermined size sliding over the pattern would give this sub-area’s absolute position in 
the pattern, regardless of its position (figure FIXME) (Geng, 2011). This is achieved by having the 
neighbouring dots of every dot in the pattern be in a unique relative position compared to the 
neighbouring dots of every other dot in the pattern. 

 

At close range, a structure scanner like Occipital’s Structure MkϮ has an accuracy of Ϭ.Ϯй of the 
measured depth (Occipital, 2020a), while costing a total of $449,- (Occipital, 2020b). 
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Intrinsic performance variables 
x D & T: As with laser scanning, the values of D and T influence the setup’s depth resolution as 

well as its sensitivity to occlusion. Decreasing D and T increases both depth resolution and 
sensitivity to occlusion, and vice versa 

x Pattern complexity: Increasing the complexity of the pattern increases the amount of 
uniquely indexed areas within this pattern, which in turn increases the resolution of the 
scan. This increase in complexity can take multiple shapes: 

o For single shot methods such as light coding, an increase in complexity would entail 
a higher resolution grid pattern, meaning more dots per area, which gives more 
unique sub-areas. 

o For multi-shot methods such as Gray coding, an increase in complexity would entail 
more frames added to the sequence to increase the amount of possible 
combinations for a line. 

x Sensor resolution: The higher the resolution of the used image sensor, the more detail it can 
pick up in in the projected pattern, which directly translates to increased depth resolution. 

 

 

Advantages 
Processing requirements 
Since simple trigonometry is used to calculate the depth of each pixel, the computational 
requirements for this method to deliver a point cloud is low, allowing for on-device processing. 

 

Non-visible light source 
The two aforementioned indexing techniques can both be performed using an IR-A projector. This 
not only reduces interference from visible-light sources, but also prevents any light related stress for 
the infant. 

 

Simplicity 
A single structured light camera can capture the depth of all objects in their field-of-view without 
using moving parts, limiting system complexity. 

 

Disadvantages 
Acquisition time (multi-shot) 
With multis-shot indexing techniques, whereby multiple images are captured sequentially, the 
subject must lay perfectly still for the acquisition to be successful. The higher the resolution of the 
scan needed, the more images must be captured, thus the longer this time will be. Infants must thus 
be either asleep during acquisition or held still by a caretaker. 

 

 

Obstruction 
Obstructions like blankets, tubes or other above-the-infant object, can cast shadow when in the path 
of the projector. If these shadows are cast on the infant, the camera will not be able to gather any 
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depth-data from those areas. This can be solved by using multiple projectors at various positions. 
However, this increases costs of the assembly. Additionally, multiple projectors would have to make 
use of a multi-shot indexing method, since static patterns could interfere with one-another. 

 

Multi camera interference 
Scanners using this technology use a projected pattern to index the surface. This means that if 
multiple scanners are used (to get full coverage of a 3D object) their patterns will interfere with each 
other. This means that a multi-camera setup using this technology must acquire its data one sensor 
at a time, sequentially.  
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Time of Flight 
If an object travels at a constant speed, it is easy to determine the distance it has travel by timing the 
duration of the travel: multiplying its speed by the travel time gives the total distance travelled. This 
principal is applied in Time of Flight (ToF) scanners. These scanners use a projector to send out a 
pulse of light. Since the speed of light is constant, the time it takes for this light to return to the ToF 
sensor can then simply be multiplied by the speed of light to get the round-trip distance travelled. 
Halving this value gives the distance between the sensor and the object. This is known as direct ToF 
(Terabee, n.d.) 

 

Indirect ToF makes use of the phase of the light being sent out by the projector vs the phase of the 
light being received by the sensor in order to gauge distance travelled (Terabee, n.d.). The projector 
sends out modulated light at a set frequency. For this example, the amplitude is modulated in a 
sinusoidal manner at 10MHz. This gives a wavelength of 30m. When the modulated light leaves the 
projector, its state is known. Depending on the distance the light has travelled before returning to 
the sensor, the phase will have shifted from its original projected state. Unlike direct ToF where the 
maximum measuring range is dependent on the intensity of the projector and the light sensitivity of 
the sensor, indirect ToF’s range is determined by the modulation frequency: a ϭϬMHz, ϯϬm wave 
can only be used to measure distances up to 15m (wavelength divided by 2). 

 

Two major types of ToF systems can be distinguished: LIDAR systems, and ToF cameras. 

 

LIDAR 
LIDAR (a portmanteau of LIght and raDAR) uses a pulsing laser and simple single point ToF sensor to 
scan the depth of a surface. Since the laser only sends out a singular beam, this system requires 
continuous mechanical movement, moving the beam across the whole surface in order to capture a 
full 3D scan. 

Recent close-range LIDAR systems such as Intel’s Lϱϭϱ have a stated depth accuracy of фϱmm (Intel, 
2019). This unit is set to sell for $349,- (Intel, 2020). 

 

ToF Camera 
A time of flight camera uses a 2-dimensional sensor and projector. Instead of a single laser point, 
multiple points of the surface are acquired at the same time. This means that unlike LIDAR, no 
mechanical system is needed to move the assembly, as long as the to-be-scanned surface fits within 
the conical field of view (FoV) of the sensor. 

A study trying to improve the accuracy of ToF cameras through software reached a depth-accuracy 
of 4.6mm within its full range (He et al., 2017), which is inadequate for the intended application. 
However, the paper does not mention if the used point cloud is the result of a single acquisition of 
the Kinect, or if an average of multiple frames are used. If only a single acquisition was used, 
accuracy might be improved by instead averaging the depth of the point cloud points acquired over 
multiple sequential frames. Microsoft priced its newest ToF camera, a follow-up to the Kinect v2, at 
$399,- (Microsoft, 2020). 
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Intrinsic performance variables 
x Clock resolution: The depth resolution of ToF based systems in dependent on the resolution 

of the clock. The smaller the time unit, the more smaller the steps between depth units 
(distance = constant speed / time). 

x Sensor & projector resolution (ToF camera): The higher the resolution of the used image 
sensor and light projector, the more detail can pick up in in the projected pattern, which 
directly translates to increased surface scan resolution. 

x Polling rate (LIDAR): Influences the speed of acquisition. The higher the polling rate, the 
faster the laser may move over the surface for the same resolution, decreasing acquisition 
time which aides in capturing dynamic objects. 

 

 
Advantages 
Low processing requirements 
With the speed of light being constant, the depth for each pixel of the camera can be easily 
determined through a simple multiplication. This means that the immediate output of the sensor 
can be used as a point cloud, thus reducing computation cost a minimum. 

 

Non-visible light source 
LIDAR systems and ToF cameras use IR-A for their projectors. This not only reduces interference 
from visible-light sources, but also prevents any light related stress for the infant. 

 

Simplicity 
A single ToF camera can capture the depth of all objects in their field-of-view without using moving 
parts, limiting system complexity. 

 

Fast acquisition (ToF camera) 
With ToF cameras the entire frame is captured at once. Because of this the subject of the scan (in 
this case the infant) does not have to lay still for more than a fraction of a second. 

 

Disadvantages 
Occlusion 
As is the case with structured light systems, obstructions like blankets, tubes or other above-the-
infant object, can cast shadow when in the path of the projector. If these shadows are cast on the 
infant, the camera will not be able to gather any depth-data from those areas. 

 

Hardware costs 
LIDAR and ToF cameras capable of scanning close range objects can be expensive compared to 
techniques like photogrammetry or some forms of structured light scanning. 



20 
 

 
Depth accuracy 
The depth accuracy of a ToF camera is determined by the precision of its clock. Since the speed of 
light is quite quick, the maximum accuracy on movable hardware is lower than other mentioned 
techniques. In fact, it is too low to be considered for this product, since HC measurements would be 
of lower accuracy than the current tape-based HC measurements.  

 

Resolution 
ToF camera sensors are of relatively low resolution compared to the average CMOS RGB sensor. For 
example, a common affordable CMOS RGB like the Raspberry pie camera has a 8  MP resolution 
(Raspberry Pi, 2016), while a modern ToF camera like the Kinect Azure, has a resolution of 1MP 
(Microsoft, 2020). In addition to this, since these cameras often have a considerable minimum 
distance they work from and wide-angle field of view, only a fraction of this resolution would be 
used to resolve the surface of the infant’s head. 

 

Range 
Both LIDAR and ToF cameras are used mostly to capture environments, rather than close-by objects. 
This is because their technology lends them better for the former, with a large potential capture 
distance and relatively low depth precision compared to other mentioned techniques. 
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Photogrammetry 
component-wise, photogrammetry is the simplest of the methods. This technique only requires 
standard CMOS sensors to capture RGB images of the to-be-scanned surface, from multiple angles. 
All 3D data is generated through software. Feature recognition is used to determine the position of 
each camera, after which multiple algorithms, amongst which is triangulation, are used to determine 
texture and geometry of the surface.  

This makes photogrammetry an almost completely software-based solution. The advantage of this is 
that a single hardware setup may last for multiple generations, since increases in scan quality are 
generally achieved through software optimizations. However, since all the heavy lifting is done in 
software, this technique is the most computationally intensive of all technologies discussed in this 
chapter. For illustration, Vectoryϯ’s Curatio scanner takes ϮϬ minutes to deliver a ϯD model, with off-
site processing. 

A study using the Curatio prototype reached an accuracy of 1.5mm with close-range 
photogrammetry (Smakman, 2014). 

 

Near-IR Photogrammetry 
Though Photogrammetry is usually performed using RGB cameras and light in the visible spectrum, it 
is possible to use cameras with an IR filter and IR light source to capture the subject. The advantage 
of this would be the ability to increase illumination of the infant using the IR light source to allow for 
better capture of the images, without disturbing the child with visible light.  

A possible disadvantage of this technique is the reduced data per photo available for the algorithm 
to resolve the to-be-scanned surface: No colour data is available, possibly reducing contrast between 
parts of the image. Additionally, the resulting grayscale images would have a lower bit-depth than 
their colour counterparts (8bpp vs 24bpp, respectively).  

However, one study comparing a near IR photogrammetry scan with a RGB scan using the same 
setup concluded that there is no difference in accuracy between the two, both reaching <1% 
deviation in measurement (Edelman & Aalders, 2018). This could thus be a viable option for the 
product. 

 

Intrinsic performance variables 
x Number of cameras: Influences object scan detail. Increasing the number of (correctly 

placed) cameras allows the reconstruction software to more accurately and with more detail 
reconstruct the to-be-scanned object. Note that returns are diminished as the number of 
cameras increases. 

x Sensor resolution: The higher the resolution of the used image sensor, the more detail it can 
pick up increasing the overall detail of the produced model. 

 

Advantages 
Hardware costs 
Photogrammetry makes use of unmodified RGB CMOS cameras. Since it is a passive 3D scanning 
technique, no emitters of any kind are needed. Though additional lighting may have to be added if 
the environment requires it, this too is standard part with no special requirements. 
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Occlusion 
While obstruction is still possible by placing objects between the camera and the subject there is no 
projector component in this system, eliminating additional possibilities of large non-scannable 
shadows being cast on the subject. Furthermore, since multiple viewpoints are a requirement for 
acquisition, objects that are in the way of one viewpoint can be compensated for by the access of 
other viewpoints. 

 

Vectory3 experience 
An advantage that is not inherent to photogrammetry itself is the experience Vectory3 has in 
creating, producing and implementing products with this technology. Scanners like their Curatio 
already make successful use of photogrammetry, and a pipeline has already been set-up to process 
acquired images offsite and return a finished mesh to the client. Additionally, this pipeline is a 
keystone in Vectoryϯ’s pay-per-scan business model, where clients pay for use of the device.  

 

Disadvantages 
Processing requirements 
Out of the discussed techniques, photogrammetry has the highest computational requirements. 
Camera position, image stitching, surface detection and more all have to be done in software after 
acquisition of the initial images. One study using photogrammetry for a head scan had a processing 
time of 49 minutes between the image acquisition and mesh output when using a desktop computer 
(Santander et al., 2020). 

 

Hardware complexity 
Though the cameras themselves are common parts, multiple are needed for one shot acquisition 
from multiple angles, increasing the complexity of the product’s design and construction. 

 

Light sensitivity 
Photogrammetry, being a passive acquisition technique, uses environmental light to acquire its 
images. This means that, even when a dedicated light source is used, performance is partially 
dependent on changes in environmental lighting conditions. 
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Conclusion 
Method Structured Light Photogrammetry Laser triangulation 
Depth Accuracy 0.6mm 1.5mm 0.36mm 
Advantages & 
Disadvantages 

Advantages 
+ Low processing 

requirements 
+ Non-visible light-

source 
+ Simple hardware 
+ Costs 

 
Disadvantages 

� Multi-camera 
interference 

� Occlusion sensitivity 
 

Advantages 
+ Hardware costs 
+ Occlusion sensitivity 
+ Company experience 
+ Costs 

 
Disadvantages 

� Environmental light 
sensitivity 

� Hardware complexity 
� High processing 

requirements 

Advantages 
+ Low processing 

requirements 
+ Non-visible light-

source 
+ Simple hardware 

(When line scanning) 
+ Costs 

 
Disadvantages 

� Complex hardware 
(When surface 
scanning) 

� Occlusion sensitivity 
� Set-up complexity 

(when line scanning) 
 

Method Time of flight 
Depth Accuracy 4.6mm 
Advantages & 
Disadvantages 

Advantages 
+ Low processing 

requirements 
+ Non-visible light-

source 
+ Simple hardware 
+ Low acquisition time 

 
Disadvantages 

� Depth accuracy 
� Occlusion sensitivity 
� Resolution 
� Range 
� Costs 

 

Having looked at common technologies for 3D scanning, a decision will now be made on what 
technologies to use for the ideation and prototyping phase. The following is a brief overview of the 
decision argumentation for each technology. 
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Laser line triangulation 
Laser line triangulation allows for adequate accuracy of the scan. Additionally, the technology does 
not require great computational power to deliver a timely result. However, human action is needed 
to place the laser line in the correct position of the head, which introduces a factor of human error 
into the measurement. This manual placement would also require the use of visible laser light, which 
can disturb the infant. This problem could be alleviated with a mechanical system that moves the 
scanning assembly, creating a 3D surface. However, introducing mechanical systems complicates the 
product, increases the amount of failure points, and potentially increases noise production, which is 
to be kept at a minimum. 

 

Because of these disadvantages, this technology will not be explored further 

 

Structured light 
Structured light scanning allows for adequate accuracy of the scan. Like laser triangulation, the 
processing of depth information requires little computational power, though the indexing of the 
pattern required by this technology does increase complexity. Since this technology can make use of 
IR-A light for its projector, the infant should not be disturbed by the acquisition. Prices for existing 
technologies are acceptable, with a Ϭ.ϭmm accuracy Structure scanner for Φϰϰϵ. 

 

This technology thus seems suitable for this application. However, since little information was found 
a unit must be acquired for testing this technology through the hood of the incubator, before 
ideation.   

 

LIDAR 
Though this technology can be used with IR-A light, thus reducing the impact on the infant, the 
mechanical system required to move the assembly increases product complexity, failure modes, and 
noise production. In addition, this technology does not have adequate depth resolution (<5mm) for 
a HC measurement that is equal to or more accurate than the tape-based HC measurement. 
Furthermore, like other active 3D scanning systems, tests would need to be performed to check the 
applicability of the technology when scanning through a curved, imperfectly transparent surface like 
that of the incubator. 

 

This technology will thus not be explored any further. 

 

ToF camera 
Though these cameras remove the mechanical component of LIDAR systems, accuracy stays below 
the required amount for an improvement upon current HC measuring techniques (4.6mm depth 
accuracy). Additionally, like other active 3D scanning systems, tests would need to be performed to 
check the applicability of the technology when scanning through a curved, imperfectly transparent 
surface like that of the incubator. 
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Therefore, this technology will not be explored any further. 

 

Photogrammetry  
Though the accuracy of photogrammetry is dependent on the configuration, Vectory3 has reached 
accuracies of 0.15mm with their Curatio hand scanner, which is adequate for the proposed 
application. Furthermore, the system requires no moving parts and the components are relatively 
inexpensive (standard CMOS cameras). 

Downsides are the product complexity due to the multiple cameras needed at multiple angles. The 
required computation time, too, is higher compared with all previously mentioned technologies. 
Vectory3 currently needs 20 minutes to process a Curatio scan off-site, which is before any 
measuring of the finished model. This would significantly impact the current procedure used for 
circumference measurement, whereby the result is immediately known to the NICU employee 
performing the measurement. 

 

A faster alternative to basic photogrammetry, which uses the same basic principle of stereoscopy, 
but combines it with an IR dot projector for creating texture on the subject, can be found in the Intel 
D4xx series of depth sensing modules. These modules increase cost, but mitigate hardware setup 
complexity by integrating much of the electronics in a self-contained module, reduce processing 
time to mere milliseconds per frame thanks to a custom ASIC in the modules, and reduce the 
systems sensitivity to environmental light by the use of the integrated IR dot projector. This 
technology will therefore be chosen to represent the photogrammetry solution. 
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E. Using the Prototype 
For the evaluation of the final prototype, it is important that other users are able to use the device. 
Therefore, this chapter serves as a step-by-step manual as well as a description of the device’s 
functioning.  

 

This guide assumes that the incubator has already been setup and the infant is placed inside. It also 
requires the following software to be installed on the host computer (the exact version of the 
software may not match, but is given as reference in case any changes are made after the writing of 
the guide): 

 

Intel RealSense Viewer (2.39.0) 

Meshlab (2020.09) 

ParaView (5.8.1) 

 

Additionally, the following two files are needed to follow the guide: 

 

D415_Setup.json 

Edge Trim.mlx 

Hardware setup 
 

1. Grab the device by the grab handles and lower it onto the hood of the incubator, with the 
device roughly aligned with the head of the infant 

 

2. Plug the power connector into the device, then the wall plug. 
 

3. Connect the USB cable to a USB 3.1 port on your computer 
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4. Open the Intel RealSense Viewer application 

 
5. Use the “Add Source” drop-sown menu in the upper left corner to add all three D415 

cameras 
 

 

 
6. Using the “load pre-configured stereo module settings” button, load the included 

configuration file “Dϰϭϱ_Setup.json” for each of the three cameras. In case this file is not 
provided, its contents can be found in Appendix P. 
 

7. Now toggle the switch for the stereo module for one of the side cameras. 

 
8. Make sure the viewport is set to 3D in the top right corner of the application. 
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9. While watching the screen, grab the handles of the device and move it forwards or back 

until the chin of the infant’s head is just in the field of view of the camera. 
 

Acquisition 
 

10. Make sure only one camera is active at a time 

 

11. Click the “export” button in the top middle of the screen 

 

12. In the export dialogue, make sure “Meshing” and “Normals” are selected. 
 

13. Save the output file to a convenient location with a recognizable name denoting which of 
the cameras took the acquisitions, as well as the current rotation of the head of the infant 
(e.g. “headUp leftCam.ply”) 
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14. Repeat steps 10 through 13 for each of the three cameras, always making sure that only one 

is active at any given time. 
 

Head Rotation 
 

15. Steps ϭϬ through ϭϰ need to be performed for three orientations of the infant’s head: Once 
while looking up, once while looking to the left, once while looking to the right. This ensures 
that the entire head can be recreated later on. Make sure that the scanner is still placed 
correctly after each movement of the infant’s head. You should end up with ϵ .ply files. 

Mesh cutting 
 

16. Open Meshlab 
 

17. Take one of the .ply files you created and drag it into the Meshlab window 

 

18. Use the middle mouse button to place the head of the infant in the middle of the navigation 
sphere. Rotate with left mouse button. 

 

19. Select the “select vertices” button in the top toolbar of the application 
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20. Drag a box around the irrelevant geometry (everything outside of the head) and press 
CTRL+DELETE to delete the selection. Do this until only the head is left. 

 

21. Go to FileхExport Mesh… 
 

 

22. Close MeshLab 
 

23. Perform steps 16 through 22 for all 9 .ply files 
 

Mesh alignment 
24. Open MeshLab 
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25. Drag all 9 .ply files into the MeshLab window 

 
26. In the top toolbar, press the “Align” button. 

 

27. In the align dialogue, select the top camera view of the infant head looking up, and press 
“Glue Here Mesh”. 

 

28. Now select a different mesh with as much overlap with the previous mesh as possible, (for 
example, in this case the left camera of the head looking left would have the most overlap, 
as well as the right camera of the head looking right). 
 

29. Press “Point Based Glueing” 
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30. In the gluing dialogue, select matching points on both meshes by double clicking on them. 

Make sure the order of the numbers matches between meshes. 
 

31. Press “OK”. 

 
32. Check if the alignment is realistic. If not, press “Unglue Mesh” then restart at step Ϯϴ. If that 

does not work you must manually place the mesh by using the “Manual Rough Glueing” 
button. [TIP: You can toggle the eyeball icons next to the meshes to temporarily hide them.] 

 

33. In the Align dialogue, press ͞PƌoceƐƐ”. The meshes will start moving towards each other. 
Keep pressing ͞PƌoceƐƐ” until the movement either stops or becomes unnoticeable. 
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34. Repeat steps 28 through 33 until all 9 meshes are aligned. 

 
35. Go to “FileхSave Project As…” to save the alignment as an .mlp file. 

 
36. Close the “Align” window. 

 

Mesh trimming 
 

 
37. Select a mesh (selection highlighted yellow) using the selection window on the right of the 

application. 
 

38. Go to Filters>Show current script 
 

39. Press “Open Script” and load the included “Edge Trim.mlx” file 
 

40. Press “Apply Script” 
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41. Go to File>Export Mesh… 

 

42. Repeat steps 37 through 41 for all 9 .ply files. 
 

Remeshing 
 

43. Got to Filters>Remeshing, Simplification and Reconstruction>Surface Reconstruction: VCG 

 
44. In the VCG dialogue, copy the above settings. 

 

45.  Press “Apply” and close the window 
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46. A new item “plymcout” has been added to the selector on the right. Disable the view of all 

other meshes and select the “plymcout” mesh 
 

47. Using the vertex selection as detailed in steps 19 and 20, select any floating or otherwise 
unwanted geometry (if applicable) and delete it using CTRL+DELETE. 
 

48. Go to File>Export Mesh As 
 

49. Give this mesh a name suitable for the final output and press “Save” 
 

50. In the “Saving Options” dialogue, make sure “Quality” and “Normals” are checked 
 

51. Press “OK” 
 

52. Close MeshLab 
 

Measuring Circumference 
 

53. Open the ParaView application. 
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54. Drag the remeshed head .ply file into the window 

 

55. Press the green “Apply” button under the “Pipeline Browser” on the left side of the screen, 
in the “properties” tab, to make the mesh visible. 

 

56. Go to Filters>Alphabetical>Slice 

 
57. Use the arrow through the plane to orient the plane and grab the plane itself to adjust its 

height in order to place the plane where you want to measure the head circumference. 
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58. Press the green “Apply” button again 

 

59. Go to Filters>Alphabetical>Triangle strips 
 

60. Press the green “Apply” button again 
 

61. Go to Filters>Alphabetical>Append Arc Length 
 

62. Press the green “Apply” button again 

 
63. The head circumference can be found in the left pane under the information tab, then the 

“Data Arrays” section. It is the second value of the variable “arc_length”, with its value in 
meters 
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F͘  Context Rig 
Since testing in the NICU at Erasmus MC is not possible, using all the previously collected data a test 
bench is set-up that allows for the simulation of most relevant aspects of the NICU. This rig permits 
for rapid testing and prototyping of ideas and concepts, which should prevent overlooked practical 
problems from arising later in the concept and embodiment phase. 

 

NICU 
 

  

The first step is recreating the relevant aspects of the NICU. Since it was previously determined that 
space would not be an issue, only the lighting situation will be considered. In order to recreate 
multiple lighting conditions, a room of the Vectory3 office featuring two layers of finely adjustable 
blinds was chosen as the NICU. A quick test with the light meter shows that it is possible adjust the 
light intensity in the room to the 55.4lux found in the Erasmus MC NICU (figure FIXME, figure 
FIXME). On a sunny day, a maximum light intensity of 667lux was reached with all blinds open (figure 
FIXME, figure FIXME), allowing for testing with the 600lux recommended limit. Reducing the light to 
0 lux requires a tarp or similar cover be put over the setup, like in the NICU. 
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Additionally, the table is height adjustable, allowing for quick test regarding ergonomics such as 
reachability. 

 

Incubator 
 

 

The most complicated part to replicate is the incubator environment. Erasmus MC lent me a 
decommissioned hood of one of their current Caleo incubators, for me to build the test rig around 
(figure FIXME). The scuffed, curved, transparent PC of this hood allows for the testing of the integrity 
of 3D scans made with various techniques through a realistic non-perfect surface. 
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In order to simulate the transparent walls of the incubator, 2 flat pieces of plexiglass, 200mm high 
are glued together and used as sides of the incubator. Since only the view for the scanner must be 
simulated these plates only have to cover half of each long side of the incubator. The short sides will 
not be used by the product since incubator designs exist where these ends are made of opaque 
material. 

 

In initial testing a white sheet is used as a mattress stand-in, featuring the same texture and colour 
as the actual mattress, allowing for a realistic contrasting background for the scanner. This sheet is 
replaced by a random noise patterned surface later, which was used for the depth accuracy test of 
the different D-series cameras.  

 

Infant 
 

 

Several baby dolls were acquired from Intertoys (figure FIXME). These dolls features a semi-realistic 
skin texture and colour, allowing for representative testing of the scanner. The circumference of the 
head of the small doll is 22cm, which corresponds to the lower limit of preterm infants that are to be 
scanned using this product (24 weeks) (Olsen et al., 2010). The larger doll features a circumference 
of 26cm (30 weeks). Finally, the largest doll features a circumference of 33cm (37 weeks) the upper 
possible limit of this device being used. More importantly, this last doll features a darker 
complexion, allowing the scanner to be tested with multiple ethnicities in mind. All dolls allow the 
limbs and head of the doll to be rotated to simulate multiple postures found in actual incubators. 
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Conclusion 

  

Though some liberties had to be taken, the final rig represents the actual situation to a degree 
where concept prototypes can be validated on it confidently. One area of caution with this rig are 
the lighting conditions. Though the actual light intensity can be managed to represent the one in the 
Erasmus MC NICU, the light colour cannot. As can be seen in figures FIXME and FIXME, the blinds 
used to darken the room have a red colouration, filtering the light and allowing more red light in 
then other colours. 
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G͘ Obtaining Head Circumference 
Head circumference of preterm infants is a measurement used to approximate cranial volume, 
which indicates neurological development of the child (Cheong et al., 2008). Since the product will 
be based on a 3D scanner, it would be possible to approximate this volume more closely than the 1-
dimensional HC measurement can through the analyses of the volume of the model. However, since 
the current standardized growth curve, the Fenton scale, uses HC as an input and not cranial volume 
to determine the development of the preterm infant, hospitals are better served with a HC value 
then the more precise cranial volume. Because of this HC will be the output of the product. 

 

The simplest way to achieve this HC measurement is to have a clear view of the entire circumference 
of the head. However, as has been described in previous chapters, this is not possible. This chapter 
describes and compares different techniques that could be used to obtain the HC measurement 
without having a full round view of the infant’s head, using partial ϯD models. The method that will 
be used needs to be determined before product design begins, since it determines what parts of the 
head needs to be scanned, influencing the layout of the product. 

 

Mirroring 
The most straightforward method of obtaining the HC without full head scan is by only scanning one 
half of the head, and mirror that half to create one whole head model which can be measured (or 
taking a partial HC using one half and doubling that value). This method requires that the half visible 
to the scanner lies on an axis of symmetry: If this is not the case (e.g. only the front half (face) of the 
head is visible) mirroring it will give a wildly inaccurate result for the HC. Therefore, only a side-view 
of the head can be used for this method. 

 

Advantages 
Single acquisition 
Only one frame has to be acquired for the HC to be calculated. 

 

Simple processing 
The partial HC value obtained from the half-head measurement can simply be doubled to obtain the 
full HC 

 

Disadvantages 
Requires good head orientation 
For the mirroring to give an acceptable HC result, the full half of the head must be visible to the 
scanner. Inaccuracies caused missing geometry on the edges because of obstruction from view are 
doubled when mirrored. 
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Multi-scan reconstruction 
A method which allows for a closer approximation of the true HC is multi-scan reconstruction. This 
technique builds on the requirement for preterm infants to have their head repositioned (read: 
turned) by caretakers multiple times a day to prevent head deformations. This causes a different 
side of the head to be facing the scanner every time the head is repositioned.  Instead of one single 
scan, multiple scans over time are made and the resulting partial models stitched together to form a 
(mostly) complete head.  

 

Advantages 
Most accurate 
Since the actual geometry of the head is used to determine the HC this technique has highest 
possible accuracy out of the discussed methods. 

 

Robust 
Since the model is made-up out of several acquisitions where overlap is possible, no single 
acquisition has to be perfect. This also allows for obscured areas (for example by tubing) to be filled 
in by additional acquisitions over time. 

 

Disadvantages 
Multi-frame acquisition time 
Unlike current tape-based HC measurements where the result is instant, this method requires 
multiple acquisitions with the wating time between these acquisitions depending on the schedule of 
the head repositioning of the infant/NICU. 

 

Complex alignment 
Since multiple scans from multiple angles over time are to be combined, the alignment and stitching 
of these scans might prove to be difficult. 

Correlated measurements 
Using a large dataset of head and facial measurements, a correlation might be found between one 
or more measurements that are visible to the scanner on a single side of the head, which allows for 
the HC to be approximated. This would remove the need for a direct HC approximation and could 
reduce the number of sensors needed if only facial features are required for an acceptable 
approximation. 
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Advantages 
Less geometry needed 
Since the measurements which are correlated to HC are all made on the face-side of the head, no 
additional cranium geometry (and thus, acquisition) is needed to determine the HC. 

 

Simpler hardware requirements 
With the geometry of only the facial area of the head necessary, the scanning hardware could be 
reduced to only a single sensor facing the infant. 

Disadvantages 
Insufficient accuracy 
Unfortunately, a backwards multiple regression analysis of a dataset of 300 new-born infants (Goto, 
2019) found that the best possible correlation between head circumference and other head 
measurements (Head Height, Height of Chin (SUM - GN), Nose width (AL-AL), Head Breadth, Face 
length (G-GN), Nose length (SL- SN)) is not accurate enough to be used in a medical setting (R2 0.602, 
Std. error 13.28mm).  

 

Feature recognition 
Some of the measurements require precise selections of areas on the face. This would most likely 
have to be done by a human operator, decreasing accuracy due to human error.   

 

Conclusion 
Mirroring 
Though adequate results should be possible using this method, a near perfect half of the head needs 
to be scanned for the result to be accurate enough. Since this perfect scan cannot be guaranteed 
due to the imperfect environment of the preterm infant, this technique is disqualified from 
implementation.  

 

Multi-scan reconstruction 
Multi scan reconstruction combines a robust reconstruction method with high possible accuracy. 
This means that the technique is better suited for the sometimes-chaotic interior of the incubator. 
Though scan times are longer than with current and the alternatively proposed methods, the 
scanner could be designed in such a way that no human interaction is needed during acquisition, 
eliminating any wating by NICU staff. These advantages and possibilities make this the best choice 
for this product. 

 

Correlated measurements 
Though this technique is promising in regard to the simplicity of acquisition, the accuracy is too low 
to be used as replacement for the current tape-based HC measurement. This disqualifies this 
technique from further implementation. 
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H͘ Cameƌa OƌienƚaƚiŽn 
Though it is established that 3 cameras are the optimal amount for capturing the relevant surface of 
the infant’s head with adequate robustness, the placement of these three cameras is not 
immediately obvious. Therefore a test setup was made to determine which of three ideated camera 
positions and orientations would give the best acquisitions. The 24 weeks infant doll was scanned 
with each setup, after which the three output meshes were compared to the Artec Eva mesh using 
Cloud Compare. 

 

The Layouts 
Three camera layouts were devised, each with their own theoretical strengths. These three were as 
follows: 

Linear Perpendicular 
This setup has all three cameras aligned in a semi-circle above the head of the infant. The cameras 
are not angled towards the infant, but instead placed flat on the incubator panes.  

The idea with this setup is that the short distance from the head will give a high resolved detail due 
to the higher pixel count used for the infant’s head. Additionally, because the cameras are placed 
flat against the incubator panes, no environmental light can cause distortion or other artifacts in the 
scans. 

 

Linear Angled 
This setup still has all three cameras aligned in a semi-circle. However, instead of the setup being 
positioned above the head of the infant, the setup is placed as far back on the incubator as is 
possible. Furthermore, instead of being laid flat against the incubator, the cameras are angled 
towards the infant’s head.  

This setup should give a better view of the top of the child’s head to the cameras which might 
increase the accuracy in that area, which is important for any future cranial volume measurements. 

 

Offset Angled 
This setup is a hybrid between the Linear Angled and Linear Perpendicular setups. The side cameras 
are setup like those of the Linear perpendicular setup, meaning that they are positioned practically 
above the infant’s head. These cameras are also placed flat against the incubator panes. The top 
camera meanwhile is setup like that of the Linear Angled setup, with the camera placed as far back 
on the incubator as possible while being angled towards the head of the child.  

The thought with this setup is that it delivers both the high resolved detail of the Linear 
Perpendicular setup, as well as capturing more of the top of the head of the infant like the Linear 
Angled setup. 
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Test Rig 

 

For the test a special setup was built to allow for easy switching between the camera layouts. This 
setup consisted of steel bars held together by clamps. The cameras were held to these rails with 3D 
printed mounting hardware. 

 

For the setups where the cameras were not flat against the incubator hood, additional measures 
were takes to keep out both environmental light, and light generated by the built-in dot-projector, in 
the shape of covering cloths for environmental light, and cardboard separators which keep the IR 
light from being reflected back into the lens by the incubator hood. 



48 
 

Results 
Linear Perpendicular 

 

The linear perpendicular setup performed best in this test. Resolved detail is highest and the 
accuracy too, slightly higher than that of the offset angled setup. 

Offset Angled 

 

As can be seen, the offset angled setup performed very close to the linear perpendicular setup. 
However, resolved detail in the face is reduced, and deviations on the sides of the head are larger 
than with the linear perpendicular layout. 
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Linear Angled 

 

This layout performed by far the worst. Resolved detail is significantly lower than with the other 
layouts, with the face seeming squashed and undefined. Furthermore, large deformations are visible 
on the back of the head.  

Conclusion 
The best performing, and thus chosen layout is the linear perpendicular layout. This layout has the 
most resolved detail an lowest deviation from the Artec model. It is clearly more advantageous to 
have the closer, and thus higher resolution and depth accuracy, than a larger distance with a better 
view of a certain part of the head, but at the cost of the overall scan quality. 
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I͘ CŽnfig file Dϰϭϱ 
The following contains the contents of the D415_setup.json file: 

{ 

    "aux-param-autoexposure-setpoint": "400", 

    "aux-param-colorcorrection1": "0.129883", 

    "aux-param-colorcorrection10": "-0.441406", 

    "aux-param-colorcorrection11": "-0.441406", 

    "aux-param-colorcorrection12": "-0.0390625", 

    "aux-param-colorcorrection2": "0.399414", 

    "aux-param-colorcorrection3": "0.399414", 

    "aux-param-colorcorrection4": "-0.0693359", 

    "aux-param-colorcorrection5": "-0.198242", 

    "aux-param-colorcorrection6": "-0.40332", 

    "aux-param-colorcorrection7": "-0.40332", 

    "aux-param-colorcorrection8": "1.00586", 

    "aux-param-colorcorrection9": "0.921875", 

    "aux-param-depthclampmax": "45000", 

    "aux-param-depthclampmin": "0", 

    "aux-param-disparityshift": "110", 

    "controls-autoexposure-auto": "True", 

    "controls-autoexposure-manual": "33000", 

    "controls-color-autoexposure-auto": "True", 

    "controls-color-autoexposure-manual": "156", 

    "controls-color-backlight-compensation": "0", 

    "controls-color-brightness": "0", 

    "controls-color-contrast": "50", 

    "controls-color-gain": "64", 

    "controls-color-gamma": "300", 

    "controls-color-hue": "0", 

    "controls-color-power-line-frequency": "3", 
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    "controls-color-saturation": "64", 

    "controls-color-sharpness": "50", 

    "controls-color-white-balance-auto": "True", 

    "controls-color-white-balance-manual": "4600", 

    "controls-depth-gain": "16", 

    "controls-depth-white-balance-auto": "True", 

    "controls-laserpower": "180", 

    "controls-laserstate": "on", 

    "ignoreSAD": "0", 

    "param-amplitude-factor": "0", 

    "param-autoexposure-setpoint": "400", 

    "param-censusenablereg-udiameter": "9", 

    "param-censusenablereg-vdiameter": "9", 

    "param-censususize": "9", 

    "param-censusvsize": "9", 

    "param-depthclampmax": "45000", 

    "param-depthclampmin": "0", 

    "param-depthunits": "10", 

    "param-disableraucolor": "0", 

    "param-disablesadcolor": "0", 

    "param-disablesadnormalize": "0", 

    "param-disablesloleftcolor": "0", 

    "param-disableslorightcolor": "0", 

    "param-disparitymode": "0", 

    "param-disparityshift": "110", 

    "param-lambdaad": "800", 

    "param-lambdacensus": "26", 

    "param-leftrightthreshold": "24", 

    "param-maxscorethreshb": "2047", 

    "param-medianthreshold": "500", 

    "param-minscorethresha": "1", 
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    "param-neighborthresh": "7", 

    "param-raumine": "1", 

    "param-rauminn": "1", 

    "param-rauminnssum": "3", 

    "param-raumins": "1", 

    "param-rauminw": "1", 

    "param-rauminwesum": "3", 

    "param-regioncolorthresholdb": "0.0499022", 

    "param-regioncolorthresholdg": "0.0499022", 

    "param-regioncolorthresholdr": "0.0499022", 

    "param-regionshrinku": "3", 

    "param-regionshrinkv": "1", 

    "param-robbinsmonrodecrement": "10", 

    "param-robbinsmonroincrement": "10", 

    "param-rsmdiffthreshold": "4", 

    "param-rsmrauslodiffthreshold": "1", 

    "param-rsmremovethreshold": "0.375", 

    "param-scanlineedgetaub": "72", 

    "param-scanlineedgetaug": "72", 

    "param-scanlineedgetaur": "72", 

    "param-scanlinep1": "60", 

    "param-scanlinep1onediscon": "105", 

    "param-scanlinep1twodiscon": "70", 

    "param-scanlinep2": "342", 

    "param-scanlinep2onediscon": "190", 

    "param-scanlinep2twodiscon": "130", 

    "param-secondpeakdelta": "325", 

    "param-texturecountthresh": "0", 

    "param-texturedifferencethresh": "0", 

    "param-usersm": "1", 

    "param-zunits": "10", 



53 
 

    "stream-depth-format": "Z16", 

    "stream-fps": "30", 

    "stream-height": "720", 

    "stream-width": "1280" 

} 
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J͘ MŽŽd bŽaƌdƐ 
This appendix features the mood boards used to determine the aesthetic design of the product. 
Three mood boards were created. One depicting NICU equipment, one depicting hospital scanning 
equipment, and one containing professional 3D scanning equipment. 

 

NICU Equipment Board 
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Medical Scanner Board 
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3D Scanner Board 
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K͘ MeƐh PƌŽceƐƐing ReƐƉŽnƐeƐ 
The following pages contain all individual responses to the mesh processing test questionnaire. 
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MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

104 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

105 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

106 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

107 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

108 YaQ 144 9-12-2020 02:07

Alex Zevenbergen



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

109 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

110 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

111 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

112 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

113 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

114 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

115 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

116 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

117 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

118 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

119 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

120 YaQ 144 9-12-2020 02:07

Alex Zevenbergen



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

121 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

122 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

123 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

124 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

125 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

126 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

127 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

128 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

129 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

130 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

131 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

132 YaQ 144 9-12-2020 02:07

Alex Zevenbergen



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

133 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

134 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

135 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

136 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

137 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

138 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

139 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

140 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

141 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

142 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

143 YaQ 144 9-12-2020 02:07



MeVh PURceVViQg TeVW hWWSV://dRcV.gRRgle.cRP/fRUPV/X/1/d/15F0PQ6ZDQQfi79CM957gYX]Q...

144 YaQ 144 9-12-2020 02:07

Alex Zevenbergen
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